Level 2-  Relational Database Project- Online T Shirt Sales.
MS Access - Creating Relational Databases
[bookmark: _GoBack]Learn what a relational database is and how to create one using  Microsoft Access.
You may have heard that Access is a relational database tool. But what is relational data? and what does it mean to you?
The answer is – quite a lot. If you can create tables, forms, Queries and reports in Access, understanding how to work with relational data is the next step in learning to use Microsoft Access.
Much of the data that you work with can, and should, be stored in a relational format. A relational database offers benefits when storing vast quantities of interrelated data. 
It makes it easy to  edit  and update the data and it reduces duplication.
This exercise shows you step by step how to create tables that are related to each other and how to access the data stored in multiple tables by querying it and reporting on it. Even if you've never used Access before these step-by-step instructions will be easy to follow. However, that said, if you need instructions for creating a simple table based database in Access this exercise will help you do so: 
What is relational data?
To understand what a relational table is let us first understand the limitations of a Flat file.
Online T-Shirts Database:
Scenario:
 Online T-Shirts is sells T Shirts and Jeans online. At the moment they are selling locally in New Zealand. They have a simple flat file database in Excel and now they want a fully working Relational database in Access Database. In the future, based on the sales they want to expand worldwide. Here is a sample database they are currently using in Excel. 
Apart from this they have a supplier who supplies the material to them. These suppliers send the price list of their products in an Excel File every month. You must update the pricelist of your database based on their pricelist, by dynamically linking Access database to  Excel.
Task: You are to develop the Given Flat File into a relational database to make it more effective. 
[image: ]Sample Flat File Database:





Study the Table carefully. See why the owner of the T-shirt company is wanting a Relational Database. Let us Identify the problems in this Flat file database.
Problems with Flat file Sample:
· The single table is holding all the details of customers, the product they bought and amount they spent.
· If the same customer buys an item second time, all the details have to be entered again, which is a laborious process. This is un necessary duplication of data, time consuming and inefficient.
· Suppose there are customers with the same first and last names it gives a lot of confusion and a wrong person could be charged for the item they did not purchase.
Solution:
· The single table should be decomposed into two tables initially. Example People and Products.
· Each customer should be given a unique id number so that people with same first and last names and even same DOB can be identified with this number.

So Let’s start. 
The process of splitting the table for efficient functioning is called Normalisation. 
What is Normalisation? Read and Understand.
•	Database Normalization is a technique of organizing the data in the database. 
•	Normalization is a systematic approach of decomposing tables to eliminate data redundancy and undesirable characteristics like Insertion, Update and Deletion Anomalies. 
•	It is used to reduce the redundancy and the duplication of data.
So the first thing we do here is to split this one table (Decompose) into two. This is called NF1 or Normal Form1.
We will also look at this problem of having customers with the same first and last names. This will cause a lot of confusion. What is the solution here???
The solution is to have a unique identification number. This is like students with same first and last names and with same dates of birth. So what is the immediate solution? To have an Id number. This will solve all the problems as each person will have unique id number.
As a result of splitting the flat file into two tables is stage 1 and is called Normal Form 1 or NF 1.

Exercise 1.
Create two tables in Access Database. One is Customer Table and the other one is Products Table.
Establish Relationship.
Open MS Access. 
First thing to do is to create a Database. 
Open Microsoft Access and Create a new file. 
Save it in a folder called AS 91368 and name the database as Online TShirts and click Create. Access opens.
From the top menu click create and click on Table. When the table opens right click on the tab and click design view. Enter the table name as tblCustomers. 
In the design view enter the following fields and set their field sizes and properties as given below.
[image: ]
Notice the key sign before the Customer ID field?
This is called Primary key. 
In order for a table to qualify as a relational table it must have a primary key.
The primary key consists of one or more columns whose data contained within is used to uniquely identify each row in the table.  You can think of the primary key as an address.  If the rows in a table were mailboxes, then the primary key would be the listing of street addresses.
When a primary key is composed of multiple columns, the data from each column is used to determine whether a row is unique.
In order to be a primary key, several conditions must hold true.  First, as we mentioned, the columns must be unique.  To clarify, we’re referring to the data within the rows, not the column names themselves.  Also, no value in the columns can be blank or NULL.
When defining a table you specify the primary key. A table has just one primary key, and its definition is mandatory.
The primary key for each table is stored in an index.  The index is used to enforce the uniqueness requirement.  It also makes it easy for foreign key values to refer back to corresponding primary key values, as we will learn about in the following section.
Exercise 2:
Now create a new table with the following fields and name the table as tblProducts. Design the table as indicated below.
[image: ]
For fields like Size and Color we can use Look up Fields. This will ensure the quick Data Entry through Drop Down box. Here is size look up wizard made for you. Repeat the same for Color field as well.
[image: ]

Did you notice the Primary Key again for Product table for Product ID? As said before, every table will have its own unique ID to identify the contents in its table. 
Another field is we have included CustomerID field in this field and the reason for this is we are going to link both the customer table and Products table through relationship. 
Please notice that the CustomerID field in Products table has a datatype of Number.  
This is a foreign key field.
See what happens if you change this to text field and try to link? 
The link does not form because for data to be linked both fields should be of number fields. 
Notice that we have added a FullName field, in which we will concatenate both first and last names to populate Customer’s Full name instead of first and last names separately. This will save our time. The idea is when the Customer ID field is chosen, the name should appear automatically.

Exercise 3: Establishing Relationships
Now let us establish the relationship between these two tables. Currently the data base is with two tables and at this stage it is called NF1.
Go to Access Database and click on Database Tools and Relationships.
Hold the shift key and select both tables.
Click Add . This will take you to the Relationships window. Simply Drag Customer ID field from Customer Table to CustomerID field of Products table. When the Edit Relationship window appears, click in Enforce Referential Integrity and click Create. 
[image: ]
What is Referential Integrity?
Referential integrity (RI) is a relational database concept, which states that table relationships must always be consistent. In other words, any foreign key field must agree with the primary key that is referenced by the foreign key.

NF 1NF1
A database is in first normal form if it satisfies the following conditions:
· Contains only atomic values
· There are no repeating groups


[image: ]






Problem with the first normal form:
Let us examine the Products table. Previously in the Flat file all the information was in a single table and we now streamlined this pack of information into two separate tables. 
But the products table now has both product information and also sales information. That means more complication. If a customer buys more products then we have to enter the whole information again and this is Data Redundancy.What is Data Redundancy
Data redundancy is a condition created within a database or data storage technology in which the same piece of data is held in two separate places. This can mean two different fields within a single database.


Solution ???
The solution is to separate the sales information from Products table. This will 
Reduce entering data multiple times. 
This means we must now modify the Products table. 
To Modify the products table, Open the relationship window and right click on the 
Line and delete relationshipRight click to delete relationship

[image: ]



Now open the Products table in Design view and Delete the following fields.
Customer ID, FullName,Date Purchased and Total Amount.
Your product table should look like below now after deleting these fields.
[image: ]
We will include these in New table called tblSales.What is NF 2
The reason we place tables in 2nd normal form is to narrow them to a single purpose.  Doing so brings clarity to the database design, makes it easier for us to describe and use a table, and tends to eliminate modification anomalies.


We now need to create NF2 which includes 3 tables.



Exercise 4
Create a New Table called tblSales
Create following fields and set primary key to the SaleID field.
[image: ]
See how we have stream lined the information.
Customer Table contains only Customer Information.
Products table will contain only product information.
Sales table  contains  the sales information  which is the link table that links information of Customer and Products
Now let us go back to Relationships window again and select all the 3 tables and click add.
Establish the relationship between the 3 tables as below. This is Called ERD Diagram- Entity Relationship Diagram
[image: ]NF 2.
Notice that Sales table is the link table with its own primary key for SaleID.
There are 2 foreign keys in this table. 
CustomerID and ProductID


Now our Database has 3 tables and looks very efficient. We have eliminated repetition of Data from tables and established separate tables. We have linked primary keys of individual tables to foreign keys in linking table. This has one to many relationships. 
Now it is time to enter the Data. The question is how to enter data? Do we enter data in the tables directly? 
The best way to enter data is through Data Entry Forms. In Data Entry Form we can enter data easily. We can make forms as user friendly as possible by using features like:
· Dropdown menu
· Buttons
· Calculated fields
· Images.
Exercise 5: Create a Data Entry Form.
An example for Customer form is shown here. Use the example and create forms for other two tables as well.
In Access, Go to top menu and click Create and choose Form Wizard in Form section of the Ribbon.
[image: ]When the wizard opens select the tblCustomers.	
[image: ]
 Click on the double arrow to bring all the fields from Available Fields to Selected Fields and click Next.
In the Next window Choose Columnar click next.
In the title field change the name from tblCustomers to frmCustomers.
Click finish and your form will now appear like below.
[image: ]	Naming Conventions:
Table : 		tbl
Form: 		frm
Query: 		qry
Report: 	rpt



Let us make some modifications to this form. To make any modifications we need to go to Design View.
Right Click on the frmCustomer tab and choose Design View. When the form opens in Design view make following changes.
When form opens in design view, click on the top menu called Design and choose Property Sheet.
Change the back color of the header section and form section.
Adjust the width of the fields.
Increase the size of the form horizontally.
Change the title from frmCustomers to Customers in header section of the form.

Example.
[image: ]

Now while you are still in Design view, Click on the Design menu and choose a button icon from the menu.
This will allow you to place a button on the menu opening the following window.
[image: ]Button 

From the Categories choose Record Operations and from Actions choose Add New Record as shown above and click Next.
[image: ]
Choose Text radio button and Add Record and click Next. Leave the Command name as it is and Click Finish.
This will put a button with name Add Record. This will enable you to create new customer record every time.
We can also add a button called Delete Record. 
Use the same methods to create a Delete button on the form.
[image: ]
Now let us add Navigation to the form. This allows us to move from one record to another. So we can add Go to Next Record and Go to Previous Record. For this we need to go to Design mode again and This time choose Record Navigation.
Choose Go to Next Record . 
Then make one more button called Go to Previous Record.
Now the form should look like below with all these 4 buttons. Arrange them as shown on the form.
[image: ]

Exercise 6: Adding a Quick Search Feature.
Suppose we want to search for a particular customer quickly, then we can use a quick search feature. This can be made by using a Combo box Which gives us a drop down menu. We can choose our customer quickly from here instead of using navigation buttons.
We can search our customers by their first or last names.
Open the form in Design View and click on the Design menu of the form.
From here select the Combo Box icon and draw a combo box in the header section next to title.
[image: ]

As shown in the picture Select the third radio button that says,”Find a record on my form based on the value I selected in my combo box”.
Click Next.


From the selection choose Customer ID and FirstName as shown below.
[image: ]
Click Next and Click Next and Click Finish.
Now Adjust the combo box properly  by moving to the right a little bit.
Change the FirstName to Quick Search.
Now your form should look like below in Deign View.
[image: ]
Once you are happy with the Form Design click close. If prompted to save changes click Yes.
Now your form is ready for Data Entry.
Exercise :7
Now create the Product Form from the Products table using the Same steps. After completion your product form should look like below.
[image: ]
Exercise 8: Creating the Sales Form.
Use your tblSales to create Sales Form. This form needs to be designed carefully as lot of coding needs to be done in this form.
Create a form in Design View using Sales Table.

In the Form Design, right click on the customer ID text field and choose Change to Combo box.
Once the field is changed to combo box, a drop down feature can be seen with a small triangle. Keep this field selected.
Now in the properties table, in the format section, change the column count to 3.
[image: ][image: ]
Now choose the data tab. In the Data tab choose row source. 	
[image: ]




	
Row source will open the query window. In the query window choose Customer Table and click Add.
Now double click on Customer ID, First Name and Last Name. The Query window will now have all these 3 fields placed in columns as below.
[image: ]
Click on the Save button and Close. Don’t click on the Save As button.
Now we are ready to write Code to concatenate the first and last Names.
While your CustomerID Field is still selected in Form Design View, Click on the Event Tab in the properties window.
Click on the last button of After Update Field.
[image: ][image: ]Opens choose builder window

Choose Code Builder and click OK.
This will open the VBAccess Code Window. This is the Visual Basic Component which enables you to write the code in Access forms.
Code builder will open the code window, now type in the following code.
 [image: ]
After writing this code Click Save button and close.                                                                           


What are these column 1 and 2??
Remember we selected CustomerID and changed to combo box and in format tab we selected column count 3. 
CustomerID- column 0
Firstname-    column 1
Lastname-     column2
In programming count start with 0
Discuss with your teacher for further understanding.




	



Now let us write the code for ProductID. This will just help us to look up for the product.
In the Sales form Design view, select ProductID text field. Change to Combo box.
In the properties window, under the format tab, make the column count 2.
Then click on the Data Tab and click the button in Row source. 
In the query window select Products table.
Select Product ID , Product  and Price fields. 
[image: ]

 Click on the Event tab and click After Update and write the following Code in code window.
[image: ]
Click Save and close.


Exercise 9: Calculating Total Price, GST and Grand Total in One Go!! 
In this exercise we will calculate Price of the product with quantity bought by customer and other calculations in just one go..
Go to frm Sales Design view.
Select Quantity text box and go to Event in property box. 
Choose After Update and click the last button. This will open the code window for you.
In the code window write the following code.
[image: ]
 This code will calculate until Grand Total Straight away.
Exercise: 10 Data Entry. Use only Forms to Enter Data.
Since we set up all our forms along with formulae, it is now time to enter the Data in the Data Entry Forms.
Enter the following Data in Customer Form.
[image: ]
Do not worry about the serial order of the Customer ID field. These numbers are automatically given by the Access itself. 
Remember you set the Data type of Customer ID to Auto Number??!!
Here is a record of how it looks in Form.   You can clearly see the difference between a table and form. Write a few points on your own experience of entering data through the form.     Explain the Usability Heuristics of Data Entry Form.
[image: ]





 Exercise 11 Entering Data in Product Form: Enter the following Data in Products form.
[image: ]

A sample record in the Sales form looks like below.
[image: ]

Exercise 12. Build up the Sales Record.
Since we now have Customer records and Product records, we now need to build up the Sales Record. 
Open the Sales form and enter the records. If you have formatted your form as per the instructions you don’t have to worry about its calculations. If you need assistance, ask your teacher.
Enter a few sales records. Here is a sample record in Sales form.
[image: ]

Use a quick search feature as before to search for a sale by Customer. Refer to the notes above. Now your form with all those extra features can look like below.
[image: ]

Enter at least 3 sales for each customer.

Summary: We have learnt how to create Tables, Forms and how to enter data through the forms. 
DIY: See if you can add a photo field for customers  and Products. You have to first create these fields in Table design and modify form design to add this field. You can use Pixabay website to collect free images. Ask your teacher for assistance.




Exercise 13: Queries:
Queries are important part of the Database. These are the one of the main building blocks of the Database. 
We can get the information we need through querying the database. This is what happens when you ask something in Google or search for a product on Trade Me or Alibaba or any online shop, or search for a friend by a name who lives in another part of the world.
Remember this is the model of Online T-Shirt Company.
Let us first make a simple query of searching for a customer by their Last Name. We can send the result of the search into a form after that.
First go to the top menu and click Create. Select Query Wizard.
From the window that appears, Select Simple query Wizard and Click Ok.
[image: ][image: ]	

From the available fields select Customer Id, Firstname, Last Name and City. Click next.
In the next window change the title to qryCustomerByCity and click Finish.
[image: ]

If you have entered different city names for customers, Here is how the table can look like.
[image: ]
But for example we want customers living in Auckland???
In the navigation pane, right click on the qry Customers by City and open in Design View. 
In the design view, under the City in Criteria Row, type [Enter City Name]
[image: ]



Click Save and Close.
Now double click the query in navigation pane to open. When it opens it will come with a window asking you to enter the parameter value - enter city.
[image: ]
In the box , enter any city.  Let’s enter Auckland. It will bring the customers from Auckland in Table format as below.
[image: ]

We can now make a form for this query, so that these records can also be displayed in a form instead of table.
Click create Form Wizard and Select QryCustomersByCity.
[image: ]
Select all the fields into selected fields. Click Next. Choose Columnar, in the title add frmqrybycity and Finish.
In the Enter Box enter Auckland and it will be displayed in Form. You can browse these records by adding buttons like previous forms.
This is how we can also display query results in a form.


This time let us enter Hamilton.
[image: ][image: ]





	It can be displayed in the form now.






So, a Query can be displayed in a table or in a form view.
Let us work on some more queries.
Exercise 13 b. qry by CustomerSpentAmount
This is again a parameter query in which we can see how much each customer spent on clothes.
[image: ]Design a new query from query wizard as below. Choose tblSales to create this query . Choose CustomerID, FullName and GrandTotal Fields.









In the criteria row, under Full name, enter the parameter value as [Enter Name]. Save query and open this query in nav pane.
You will get the following results.
[image: ]	[image: ]

But, we want to know the Total Amount she spent, which is Sum of Grand Totals. 
We will work this out in the Report. 

Exercise 14 Access Reports.
As mentioned earlier, the four building blocks of a Database are:
· Tables
· Forms
· Queries
· Reports.
A report is a consolidation of business activities which are made for making business decisions that affect the way business works. Normally management seeks these reports to make informal decisions and  gives  an overview of trends in business. This will help them to make necessary changes to their trade.
The order of creating reports is : 
· Use Table to create a Query.
· User Query to create a Report.
· So queries are pre requisite for making reports.
Let us make a Report using our two queries. First we will use qryByCity.
Go to the top menu and click Create and choose Report Wizard in Report Section of the ribbon.
[image: ]
Select all the fields of qryCustomerByCity into Selected Fields area and click Next. 
The next window will ask you if you want any grouping levels.
[image: ]
Select CustomerID and click the forward arrow. This will keep CustomerID at the top and highlighted blue color.
[image: ]
Click Next
When asked for Ascending or Descending order, you can choose by FirstName. Click Next.
Keep the layout to ‘Stepped’ and Orientation to ‘Landscape’.
[image: ]
Click Next.
Change the title to rptCustomerByCity. 
[image: ]
Click Finish. When you click Finish it will again ask you to enter the parameter value. Remember, we set up our query that way originally!
[image: ]
Enter any City and your report will open.
Here is the rptCustomerByCity.
[image: ]

You can see the first names arranged in ascending order. When we enter for example Auckland, all Auckland Customers will appear in the report.



Exercise 14 a. Report based on Customer Spent Amount.:
Let us now create another report based on our query we made to see how much a particular customer has spent in Total.
As indicated before, we can create sum of Grand totals in Report view. 
For Example, a customer Vinolia Baxter has spent $80.00+$80.00+$104.00.
We can calculate the sum of the GrandTotals in this report.
So let us create a report now.
Select the querybyCustomerSpentAmount in nav pane. Go to Create Report and click Report Wizard in Report section of the ribbon.
Repeat the steps
[image: ]
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[image: ][image: ]
Adjusting Report View: Right click on the                                    	and select Design View.
We will Move the customer id number below the CustomerID label and Move the Full name field to the left and adjust Grand Total field.








[image: ]


You can see the Sum of Grand Total appearing at the bottom, this is because we clicked in the Sum box in Summary Options. Save and close.
So now let us see how our report appears.
[image: ]

Congratulations! You have almost completed the Database.
The standard requires you to Implement advanced procedures to produce a specified digital information outcome with dynamically linked data.
Let us now look at what a Dynamic Link is.
· A Dynamic Link is when you are using tools of the software to integrate data from a database and at least one other software application using dynamic linking.
This One other software we will be using  to integrate data into our Database is a Spreadsheet File. 


As indicated in the beginning, a supplier supplies material to the Tshirt company which sells to us online. They send the pricelist every month in excel sheet. We must update our prices based on this excel file.
Here is the Price List Excel File. You can create this file in Excel by Copying your Access Products table and paste it in Excel file and name this as PriceList. This file should be located in the same folder as your Database file or it may not work.
	ProductID
	Product
	Size
	Color
	Price

	1
	T-Shirt
	S
	Black
	$30.00

	2
	T shirt
	L
	White
	$25.00

	3
	T Shirt
	XL
	Yellow
	$33.00

	4
	T Shirt
	XL
	Green
	$25.00

	5
	T Shirt
	M
	Orange
	$23.00

	6
	T Shirt
	S
	Blue
	$37.00

	7
	T Shirt
	XXL
	Black
	$45.00

	8
	Jeans
	S
	Black
	$45.00

	9
	Denim Jeans
	XL
	Brown
	$35.00

	10
	Light Jeans
	M
	Black
	$25.00



 






Exercise:15 Establishing a Dynamic link between Database and External File (Excel)
Open your Access Database. Select the tblProducts. Don’t open it. Just select so it is highlighted in pink.
Go to External Data on the top menu.
Under the Import and Link Section click on Excel.
[image: ]
This will open the following window.
[image: ]
Browse to the folder where your pricelist excel file is and open it. 
Click the Radio button ‘Link to the data source by creating a linked table’
Click Ok. This will open the link spreadsheet wizard.
[image: ]
Click in the ‘First row contains column headings’
Click Next.
Change the Linked table name to PriceList. (P capital, L capital and no space.)
Click Finish and this will prompt following message.
[image: ]
 Click OK.
When you click OK, you can see both your Products table and PriceList table are highlighted in Pink.  
You can also see a blue arrow in front of PriceList indicating the dynamic link is established.
[image: ]

Now let us say, we have a new excel file sent by supplier. For this go to Excel file and change the price by increasing $5 for each product and save.
Excel price list changed in original place. 	
	ProductID
	Product
	Size
	Color
	Price

	1
	T-Shirt
	S
	Black
	$35.00

	2
	T shirt
	L
	White
	$0.30

	3
	T Shirt
	XL
	Yellow
	$38.00

	4
	T Shirt
	XL
	Green
	$30.00

	5
	T Shirt
	M
	Orange
	$28.00

	6
	T Shirt
	S
	Blue
	$42.00

	7
	T Shirt
	XXL
	Black
	$50.00

	8
	Jeans
	S
	Black
	$50.00

	9
	Denim Jeans
	XL
	Brown
	$40.00

	10
	Light Jeans
	M
	Black
	$30.00


[image: ]Now let us see if it changed in linked file in Access.


Yes it has changed. 
But let us see if it changed in product table in Access.
[image: ]
Compare the prices in products table. It has not changed.
How can we change this price?
We need to use Update Query to change this price of products table.
So when you change the pricelist price it will show changes in linked file but to change the price in products table we need to use Update query.
Exercise 16.Using Update Query.
Create a simple query first as follows. In the query wizard window just select tblProducts and choose only Product ID and Price fields to go into selected fields area. Click next.
[image: ]
Click Next and Next and in title change the title as qryPriceUpdate and click Finish.
[image: ]
Close the query table and open this query in Design View.
[image: ]




Go to the top  menu click Design Tab and click Update.
[image: ]
This will give the Update  To field  in query window.
[image: ]
Right click in the grey space next to tblProducts 
[image: ]
Select Show Table and select PriceList and click Add. The price list table will be added to your query window. Now draw a line with cursor from product id to product id of the other table as below.
[image: ]
This means both are linked to each other. 





[image: ]Now in the Update To Row, under the PriceList, right click and build.

 









	Build opens the following Expression Builder Window.   
[image: ]
Click on the plus sign of  TShirt Sale Exercise and Tables and click PriceList. 
In the Expression Categories, Double click Price which will Put [PriceList]![Price] in the expression area.
Click Ok.
Now in the nav pane you can see the price update query as follows.
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Operating the Update Query.
So how do we update the price in our products table? Let us see how our prices are looking in linked table first.
	Price in Linked table Price List (Excel)
	Price in Products Table.

	[image: ]
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It did not change in the Products Table.
So now double click the PriceUpdateQuery you made and see what happens? You get this message first.
[image: ]
Click Yes . This will prompt another message.
[image: ]
Click Yes. This will pop us how many records it is updating.
[image: ]
Click Yes.










Now let us compare the prices again.
	Price in Linked table Price List (Excel)
	Price in Products Table.

	[image: ]
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Now let us have one Final Comparison side by side.
	Price in Products table Before Update
	Price in Products table After Double clicking Update Query

	[image: ]
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This Update Query is useful to change the data in Access from Externally linked table. 
It is important to create a switchboard at the end of the project.
Here is the link on how to make a switch board.
https://support.office.com/en-us/article/create-and-use-a-switchboard-f8b3d607-8f1f-4ecf-9979-79b1565f5471











Exercise 17: Mail Merge
In this exercise we will use our customer data to populate addresses to send News Letters to our customers.
Create a word documents and Paste the following content.
A Happy New Year and a warm Welcome to our T-Shirts Club members. We are constantly striving to bring great deals to your door step, so you can enjoy wearing our T-Shirts. We hope you are liking our new designs and colors.
Thank you for pressing us to move to other colors from white and black. The response is great and we have great demand for other colors too!
We have recently got some new requests to have some abstract designs on T Shirts and we are working on it. 
Last month we have introduced  Design your Own T Shirt  Competition.
 We received a huge response for this. 
[image: ]Here is the winning entry sent by Peter Potter from ChristChurch.



 


We invite you send your entries for our next month’s competition. 
Last month we  donated T Shirts for our walking school bus group. We will be donating more T Shirts for  the Blood donation camp happening in Auckland in March this year. $0.25 cents from your purchase will go towards these  groups.  
We love your support and contribution. Feel free to join our T Club to win a free T Shirt!! This offer is available until March this year.
Have a happy time in our T Shirts. 
See you next month!!
To :
Use database to mail merge the addresses here.
Format the NewsLetter using attractive colours and themes to make it presentable.

How to use the base letter to mail merge:
Open Microsoft Word
Go File , New and in the new section type in NewsLetter and click the magnifying glass next to it.
[image: ]
This will open a number of News Letter Templates. You can choose a Template to create this newsletter.


I used a template to create a Newsletter and copied and pasted the matter from this document. My News Letter now looks like below with two pages.
[image: ]
I will be using this blank  space to merge my Newsletter with Customer Data from the Database.
I have used this space to insert mail merge information to create a merged letter.
[image: ][image: ]
 After Merging the Newsletter
Inserted Database fields

To Understand how to mail merge using newsletter, watch the you tube videos or ask your teacher for assistance.
Here is the link to learn how to mail merge.
https://edu.gcfglobal.org/en/word2013/mail-merge/print/

One Last Word
This concludes the Database Exercise starting from tables to reports and other associated documents such as News letter.
This is the completion of the whole Database project. You can use this concept for all other Dynamically linked Databases. 
A final look into how we did the project.
· Read the brief thoroughly.
· Plan your work and write a synopsis on how you are going to create your database.
· Understand what the client wants and highlight the important points.
· Gather your resources.
· Create folders with appropriate names. 
· Plan how many tables you want to design
· Design each table carefully with Field names, data types and descriptions
· How you are going to establish relationships
· Make sure you have primary and foreign keys.
· Test your tables with some test data.
· Correct the errors.
· Make screenshots of the work.
· Create Forms for Data Entry.
· Make the forms user friendly with helpful features such as buttons and combo boxes for  easy navigation.
· Create queries as per the requirement.
· Create Dynamic Links using other software programs such as Excel or Word.
· Use queries to create reports.
· Use Database to create Mail Merge document.
· Test your database several times with test data to see if validation rules are working.
· Finally create a Switchboard.
· Document all your work. 
· One last word…. Do not hesitate to ask for help! Your teachers are here to make you understand the subject!!
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